
Loading a Truck Manifest 

Introduction 
This chapter explains how to use MaxLoad Pro to load a truck manifest 
with multi-size cases or multiple SKU's into a container.   

Note:  If you're loading single-SKU's into a container, you'll use the 
Single-SKU Manifest.  For more information, please refer to Chapter 7, 
Loading a Single-SKU Manifest. 

This chapter walks you through the process you’d most likely follow when 
building a load with multi-size cases, including the following topics: 

 Truck Manifest Pick List Screen 

 Vehicle Tab 
 Options Tab 
 Algorithm Options 
 Truck Weight Limit 
 Mixed Pallet Tab 
 Comments Tab 
 SKU List 
 Manifest List 

 
 Expand Columns in the SKU List and Manifest List 

 Defining a Truck Manifest 

 
 

 
Chapter 4:  Loading a Truck Manifest 4.1 



Truck Manifest Pick List Screen 
Once you’ve logged into MaxLoad Pro, the first screen that appears is the 
Control Center.  To start a new truck manifest, start from the Control 
Center and click on the New button under the Truck Manifest icon.   

System Response:  The Truck Manifest Pick List screen appears, as 
pictured below. 

 
Figure 4.1 Pick List Screen (Truck) 

With the Truck Manifest Pick List screen displayed, you’re ready to begin 
defining the components of a new manifest.  This screen is the basis for 
collecting data for building a new manifest.  The Truck Manifest Pick List 
screen is comprised of the following components: 

 Vehicle Tab: Allows you to select the type of vehicle and the specific 
vehicles to be used for the manifest.. 

 Options Tab:  Allows you to fine-tune your load to get optimum 
results. 

 Mixed Pallet Tab:  Work performed under the Mixed Pallet tab 
allows you to set defaults for loading a mixed pallet. 
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 Comments Tab:  Allows you to enter comments for the manifest. 

 g.o.d. Window:  Displays a 3-dimensional graphical image of the 
vehicle. 

 SKU List:  Displays a list of all SKU’s (shipcases, drums, etc.) you've 
defined in the Define SKU screen(s).  All SKU’s in this list are 
available for loading into a vehicle, onto a pallet or into a tote. 

 Manifest List:  Displays a running list of all SKU’s to be loaded into 
the vehicle.  As you select SKU’s from the SKU List, they will 
automatically appear in the Manifest List.  You will define specifics 
about the load in this list. 

 View Button:  Allows you to view a load without recalculating it.  
This feature works only if you’ve previously built a load and is used 
primarily after you’ve made changes to a load in the Editor screen. 

 Calculate Button:  Allows you to calculate a load. 

Vehicle Tab (Truck Manifest) 

The Vehicle tab, allows you to select the type of transit container (Truck, 
Sea Van, Rail Car, etc.) for a manifest. 

 
Figure 4.2 Vehicle Tab (Truck) 
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The Vehicle tab contains the following components/fields: 

 Vehicle Type:  Displays the various kinds of containers defined in 
MaxLoad Pro.  You can narrow down the list of available vehicles by 
choosing a Vehicle Type.  This action will filter the Available 
Vehicles list to display only one type of vehicle. 

 Available Vehicles:  Displays a list of all vehicles available in the 
vehicle database.  In order to build a load, you will need to either 
choose an existing vehicle or define a new one though the Define 
menu. 

Double click on a vehicle in Available Vehicles list to move it to the 
Selected Vehicles list.  Also notice that as a vehicle name is 
highlighted, a representation of that vehicle displays in the g.o.d. 
(graphical on-line drawing) window. 

MaxLoad Pro allows you to load multiple vehicles at one time.  To do 
so, select more than one vehicle to be analyzed when calculating a 
manifest.  Simply follow the procedure described above to select 
multiple vehicles.   

 Selected Vehicles:  Displays the containers selected from the 
Available Vehicles list, for a particular manifest. 

When MaxLoad Pro calculates solutions for a manifest, it uses only 
those vehicles listed in the Selected Vehicles list.  To remove a vehicle 
from this list, double-click on the vehicle you wish to remove, in the 
Selected Vehicle list.  This will remove the vehicle from the Selected 
Vehicles list and place it back in the Available Vehicles list.   

A representation of the selected vehicle will appear in the g.o.d. 
window.  If you select multiple vehicles, the highlighted vehicle will 
appear in the g.o.d. window.   

 View Button:  The View Button is active if you’ve opened an existing 
analysis or a new analysis has been calculated. It opens the Manifest 
View screen. 

 Calculate Button:  The Calculate button will instruct MaxLoad Pro to 
find loading solutions based on the parameters entered in the analysis. 
When the calculation is complete, MaxLoad Pro opens the Manifest 
View screen. 
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Options Tab (Truck Manifest) 
The Options tab, allows you to further customize your manifest by setting 
various loading parameters. 

 
Figure 4.3 Options Tab (Truck) 

The Options tab contains the following fields: 

 Use Unit Loads:  Check the box to turn on the Unitload column in the 
Manifest List.  When you turn on this column, you can designate a 
SKU to be loaded onto a pallet as a completed unitload. 

Note:  A unitload differs from a mixed pallet.  A unitload is comprised 
of identical SKU’s, while a mixed pallet is comprised of multiple 
kinds of SKU’s. 

 Use Mixed Pallets:  Check the box to turn on the Mixed Pallets 
column in the Manifest List.  Mixed Pallets are pallet loads consisting 
of multiple kinds of SKU’s.   

 Load By Priority:  When a SKU is assigned a high priority number, it 
will be loaded before a SKU with a lower priority number.  Priority 1 
will be loaded before priority 2, which will be loaded in front of 
priority 3. 

Note: Load By Priority and Load By Stop Off determine which 
column is displayed in the Manifest List:  Priority or Stop-Off.  You 
can select either Load By Priority option or Load By Stop Off, but not 
both.    
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 Load By Stop Off:  When you load by stop-off, the loading method is 
just the opposite:  Stop-off 1 is loaded after stop-off 2, and therefore 
closest to the rear door; stop-off 2 is loaded after stop-off 3, etc. 

Note:  The following two options (Keep Same Orders Together and 
Keep Like SKU’s Together) work in conjunction with the stop-offs 
and priorities.  In other words, if you build a load with two stop-offs, 
MaxLoad Pro will keep like SKU’s or orders together within the 
individual stop-off number. 

Bear in mind that using either of these options could potentially result 
in less cubic utilization.  While we can’t definitely say how these 
options will affect a load, it’s safe to say that these options will affect 
MaxLoad Pro’s calculations, thus making it possible that the load will 
be affected negatively.   

 Keep Same Orders Together:  Check the box to keep the same 
orders together when loading.  This field is directly linked to the Order 
# field in the Manifest List.  When you key in an order number, 
MaxLoad Pro gives you the option to group SKU’s from the same 
order together.  If you do not choose to input order numbers, this field 
will be meaningless; activating the checkbox will not affect the 
placement of SKU’s within your manifest.   

 Keep Like SKUs Together:  This option is very similar to the Keep 
Same Orders Together option.  Activating this option tells MaxLoad 
Pro to load all products with the same SKU number together.  The 
Keep Like SKU’s Together option takes precedence over the Keep 
Orders Together checkbox, thus answering the question of what 
happens when both boxes are checked. 

 Load by SKU Ratio: This option loads the container with the 
specified ratio of SKU’s in the Manifest List. When this option is 
checked, enter the ratio of the respective SKUs in the Qty column. 

For example, to load the container with SKUs A, B and C in the ratio 
of 2:3:1, enter in the Qty column 2, 3 and 1 for SKU-A, SKU-B and 
SKU-C respectively. 

 Minimum Ceiling Clearance:  Minimum ceiling clearance is the 
minimum amount of air space allowed between the top of the cargo 
and the ceiling of the vehicle.  This option was designed with 
refrigeration and frozen shipments in mind, which require “breathing” 
space for freight so that a consistent temperature will remain 
throughout the vehicle.   

Enter a number that represents the minimum amount of empty space 
required above the cargo.  Keep in mind that this space starts at the 
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point above the tallest SKU in the load.  If your cargo does not require 
a clearance between it and the top of the transit vehicle, you can tab 
through this option and go with the default of zero inches. 

 Maximum Vertical Gap:  This option lets you control which spaces 
MaxLoad Pro joins together for the purpose of loading other items on 
top.   

In the process of loading SKU’s and pallets into a transit vehicle, 
MaxLoad Pro accumulates a list of “leftover” spaces.  Whenever 
possible, MaxLoad Pro will combine neighboring leftover spaces to 
make bigger spaces.  Ideally, these neighboring spaces present a level 
surface.  If they do not present a level surface, you can enter a value in 
this field that artificially “joins” the two uneven surfaces together, thus 
creating a larger level surface.   

If the difference in height of the two spaces is less than or equal to this 
value (in English or Metric units), MaxLoad Pro joins together the 
offending gap, assuming that you will pad or brace the shorter space to 
bring it up to the height of the taller space. 

 Maximum Priority Overlap:  MaxLoad Pro uses this option to 
determine the placement of the next priority or stop-off.  This field 
allows you to define the distance inside the container that MaxLoad 
Pro will “mix” items of a different priority or stop-off.  This field 
determines how far forward into another priority or stop-off the front 
of an item with a lower priority number will be placed.   

For example, if maximum priority overlap set to 30 inches, MaxLoad 
Pro will place the next priority on top of the previous priority, with the 
front of the lower priority protruding past the end of the higher priority 
freight by a maximum of 30 inches. 

Some shippers cannot mix stop-offs and will build a physical bulkhead 
of plywood bracing between SKU’s of two separate stop-offs.  In this 
case, you would key in a value of zero in this field, which tells 
MaxLoad Pro to place the next stop-off on the floor, regardless of the 
fact that there is enough room to load on top. 

 Algorithms Button:  This button displays the Algorithm Options 
dialog box which allows you to determine how MaxLoad Pro will load 
a manifest.  For more information, please refer to the next section. 

 Weight Limit: Check this box to activate the weight limit option.  The 
Weight Limit button displays the Truck Weight Limit dialog box, 
which allows you to set up weight limits for king pins and axles based 
on different regions of the country.  For more information, please refer 
to the section, Truck Weight Limit on page 4.12.   
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Algorithm Options 
The Algorithm Options dialog box, allows you to determine how 
MaxLoad Pro will load a manifest.   

 
Figure 4.4 Algorithm Options Dialog Box (Truck) 

The Algorithm Options dialog box contains the following features: 

Algorithms 

 Load Front to Back:  Check the box to load the manifest as high as 
possible and as far forward as possible.  This option is useful if you 
put together a quote for a customer and want to show the amount of 
empty floor space available in the vehicle. 

Loading front to back may use only half the available floor space, 
thereby placing most of the loaded weight on the vehicle’s drive axles.  
The overall cubic efficiency of the trailer will likely be very similar, 
but the difference will be in the placement of the unused cubic space 
(above the freight with the Load Front to Back option, behind the 
freight with the Load Floor to Ceiling option).   
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This option loads the container, starting at the front edge of the 
container and working towards the opposite edge, stacking mixed or 
identical SKU’s or pallet loads.   

 Space Evenly:  Check the box to spread a load over the entire surface 
area of the container in order to make a more secure load.   

Whenever the cubic measurement of the cargo is less than the 
available cubic capacity of the load – remember that you define 
parameters of height and weight to define the cubic capacity – an 
artificial “ceiling” will be created.  This lowers the maximum height of 
the load and forcing it to be spread as equally as possible over the 
surface area of the vehicle. 

 Load Floor to Ceiling:  Check the box to distribute the load evenly 
across the entire floor space of the transit vehicle, thus balancing the 
load more evenly between its axles.  This algorithm option minimizes 
unused floor space, making for a more stable load. 

Optimize 

 Left-to-Right Optimization:  Check the box to have MaxLoad Pro 
look for the best combination of two placements in order to maximize 
the space across the width (i.e. left-to-right) of the vehicle 

When this box is checked, MaxLoad Pro will attempt to find some 
combination of two placements to optimize the width of the vehicle.  If 
the box is not checked, MaxLoad Pro will strive to place the largest 
placement possible in the vehicle, but will not necessarily attempt to 
maximize the space across the width of the trailer.   

It’s important to understand that this algorithm does not always 
provide the best solution, even though the logic behind the algorithm 
would suggest that it would.  Why?  Because of the physical 
dimensions of the SKU’s being loaded into a vehicle, there simply 
may not be a combination of two placements that can maximize the 
width.   

Note:  When you select multiple algorithms, MaxLoad Pro will 
display at least one solution for each algorithm chosen.  Additionally, 
whenever Left-to-Right Optimization is turned on, MaxLoad Pro will 
calculate two solutions for each algorithm chosen; that is, Front to 
Back, Floor to Ceiling and Space Evenly. 
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 Speed-Space Tab:  Move the sliding bar to optimize the calculation 
for speed (flush left) or for efficiency (flush right). 

The For Speed option tells MaxLoad Pro to calculate solutions as 
quickly as possible. 

The For Space option tells MaxLoad Pro to take more time and 
calculate the most space-efficient solutions. 

When you click OK, in the Algorithms dialog box, MaxLoad Pro 
saves your algorithm options to memory and returns you to the Truck 
Manifest Pick List Screen.   

The next time you calculate solutions for this manifest, MaxLoad will 
display a progress dialog box, as pictured below. 

 
Figure 4.5 Progress Dialog Box 

Notice the following about this dialog box: 

 The dialog box displays a running count of the following 
parameters for the current calculation:  quantity, cubic efficiency, 
cut list count, solution count, truck number and time elapsed. 

 
 A Stop button allows you to stop the calculation at any time and 

gives you the best solution found so far. 
 

 Pinwheel Optimization for Pallets:  Check the box to have MaxLoad 
Pro load pallets in a pinwheel pattern in a container.  
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Staggered 

The staggered pattern is used to load round shape SKU’s, like drums, pipes, 
etc. into a container.  MaxLoad Pro gives the following options to load 
cylindrical SKU’s into a container.   

 None:  This option assumes that cylindrical objects are rectangular 
SKU’s and loads them in a linear fashion as a shipcase.   

 Tight:  Loads as many cylindrical SKU’s as possible along the width. 

 Spread:  This is to spread the round SKU’s during loading. 

 Pyramid:  This is for loading the cylindrical SKU’s lying in length 
orientation in the truck, stacking in a pyramid shape.   

Unitload Options 

 Smart Pallet Placement:  Check this box to have MaxLoad Pro place 
stable unitloads and mixed pallets on the floor of the container and 
then load the uneven palletloads as part of the top layer.   

 Optimize Height for Top Layer:  Checking this option gives the 
software the ability to load partial unitloads, thus more efficiently 
utilizing the container space.   

For Example:  Suppose you are loading a 48 Ft. Dry Van with 60 
inches high unitloads.  A 48 Ft. Dry Van is 110 inches in height and 
you have set a Minimum Ceiling Clearance of 10 Inches.  This leaves 
behind 40 inches of wasted space.  Now, with checking the “Optimize 
Height for Top Layer”, MaxLoad Pro will create unitloads with height 
in the range of 40 inches for the top layer, thus utilizing the container 
overhead space.   

 Allow Loose fill on sides:  Checking this option allows MaxLoad Pro 
to load the selected SKUs as fill items.  The SKUs which are left 
behind as they do not form a complete unitload can be used as fill 
items, to fill the empty available space in the container.      

Keep Order on Same Truck 

When this option is checked, MaxLoad Pro will keep SKU’s with the 
same order number on the same truck. 
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Truck Weight Limit 

To set up weight limits for king pins and axles based on different regions 
of the country, follow these instructions: 

 
Figure 4.6 Truck Weight Limit Dialog Box 

1. Enter information in the following fields: 

 Region: Use the drop-down list to select a region of the country. 

 King Pin: Enter the weight limit for the king pin – based on 
regulations in the selected region – in pounds or kilograms, 
depending on the Units selected. 

 Axles: Enter the weight limit for the axles based on regulations in 
the selected region. 

2. If all the weight limit information is correct, click on OK else click 
Cancel. 

System Response:  MaxLoad Pro saves the weight limit data to the 
database. 

 Edit Regions Button: The Edit Region allows you to set up new 
regions, edit or delete existing regions.  

To create a new region, start from the Region dialog box and follow 
these instructions 

1. Click on the Edit Regions button. 

System Response:  The Region dialog box appears, as pictured 
here. 
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Figure 4.7 Region Dialog Box 

2. Click on the New button. 

System Response:  The Region dialog box redisplays with all 
blank fields. 

3. Enter information in the following fields: 

 Region: Enter the name of the new region. 

 King Pin: Enter the weight limit for the king pin . 

 Axles: Enter the weight limit for the axles.  

4. If all the new region information is correct, click on the Save 
button. 

System Response: MaxLoad Pro saves the new region to the 
database. 

To edit a region, start from the Region dialog box and follow these 
instructions: 

1. Use the Region drop-down list to select the region you want to 
edit. 

2. Edit king pin and axle weights as necessary. 

3. If all the updated weights are correct, click on the Save button. 

To delete a region, start from the Region dialog box and follow these 
instructions: 

1. Use the Region drop-down list to select the region you want to 
delete. 

2. Click on the Delete button. 
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Mixed Pallet Tab (Truck Manifest) 

The Mixed Pallet tab, allows you to set defaults for loading SKU’s onto a 
mixed-pallet.  In order for MaxLoad Pro to use the information you enter 
on this tab, you must first activate the MP column in the Manifest List.  

 
Figure 4.8 Mixed Pallet Tab (Truck) 
 

Note:  The work you do in this tab is not to be confused with the work you 
do when you click on the Pallet Manifest icon in the Control Center 
screen. 

The Mixed Pallet tab contains the following fields. 

 Pallet:   Allows you to select from various types of pallets and 
slipsheets already defined in the Pallet database.  If you click on the 
down arrow, the list of existing pallets displays.  Scroll through the list 
and select a pallet or slipsheet. 

We ship MaxLoad Pro pre-loaded with a range of popular pallet styles.  
However, if you can't find a pallet or slipsheet that you want to use for 
this manifest, you can always define a new one.   

For more information, please refer to Chapter 3, Defining MaxLoad 
Pro Databases. 

 Maximum Height Incl. Pallet:  Enter a value representing the 
maximum height the mixed-pallet is allowed to be.  Reminder:  the 
height value includes the pallet height.   

 Maximum Weight Incl. Pallet:  Enter the maximum allowable 
weight of the mixed-pallet.  Reminder:  the weight value includes the 
pallet weight.   

 
4.14 MaxLoad Pro (V2.7X) User's Guide 



 Maximum Length and Width Overhang:  These values represent 
the maximum distance a SKU can hang over the edge of the pallet.  
The overhang dimension is illustrated below. 

 
Figure 4.9 Overhang on a Pallet 

For the purposes of building a stable load, we recommend that you 
limit the maximum overhang to at least one-half the length of the 
smallest SKU to be used in this manifest.  This will ensure that no 
SKU will have the majority of its mass hanging off the edge of the 
pallet. 

When MaxLoad Pro builds a mixed-pallet load, it will use as much of 
the “available” space on the pallet as possible.  The amount of usable 
space is determined by the pallet size, the amount of overhang 
allowed, and the maximum height allowed to build a load.   

In effect, MaxLoad Pro uses this information to build invisible “walls” 
representing the absolute parameters of the mixed-pallet load.  In fact, 
when viewing a load you'll notice that the usable area is shaded a 
different color to differentiate it from the background of the diagram. 

 Maximum Vertical Gap:  Enter the maximum distance that MaxLoad 
Pro will artificially raise an SKU when it is placed next to a taller 
SKU.  By raising the height of the SKU, MaxLoad Pro combines two 
separate “spaces” (level surface) on top of each individual SKU into 
one larger space on top of both SKU’s.  The larger space gives 
MaxLoad Pro more freedom when determining which SKU to load 
next.   

 Load into vehicle:  Select from one of the options as how the mixed 
pallets will be loaded into the vehicle: By Length, by Width or by Best 
Fit, meaning MaxLoad Pro will load the unitload in the container 
where it is most efficient in relation to the other items in the manifest.   
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Comments Tab (Truck Manifest) 

The Comments tab, allows you to enter up to three separate comments 
regarding the truck manifest. 

 
Figure 4.10 Comments Tab (Truck) 

The Comments tab contains the following fields. 

 MFT Comments 1:  Enter comments regarding the truck manifest. 
Comment 1 appears in the title section of all printouts.   

 MFT Comments 2 & MFT Comments 3:  Enter comments regarding 
the truck manifest to appear on Load and Load Front to Back view 
printouts only.   

SKU List (Truck Manifest) 

The SKU List, as pictured below, displays a list of all SKU’s (shipcases, 
drums, etc.) you've defined in the Define SKU screen(s).  All SKU’s in 
this list are available for loading into a vehicle, onto a pallet or into a tote.  
SKU’s will automatically appear in this list as they are defined.   

When you click on a SKU, a blue bar highlights it.  The gray vertical 
scroll bar to the right of the box scrolls the database list and allows you to 
view more SKU’s.  The scroll bar will take you to the bottom of the list or 
to the top of the list. 
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Figure 4.11 SKU List (Truck) 

This list contains useful information about the SKU.  All of this 
information is designed to help you make quick and easy decisions about 
the items you’re shipping. 

 SKU Type:  This column contains icons representing the SKU Type: 
unitload, shipcase, drum, tote or mixed pallet. 

 SKU:  This column contains the SKU Number, as defined in the 
Define SKU screen.  

 Description:  This column displays the full description of the SKU.  
As with the SKU column, contents of this column appear exactly as 
they are defined in the Define SKU screen. 

 Dims:  This column displays the dimensions of each individual SKU.  
The dimensions will appear either in English or Metric units, 
depending on which units are selected in the Toolbar. 

 Wgt:  This column displays the defined weight of the SKU.  As with 
the dimensions column, this column will either appear in English or 
Metric units, depending on which units are selected in the Toolbar. 

 SKU Info 1, SKU Info 2, & SKU Info 3:  These fields display the 
information saved under the Graphics tab while defining the SKU.   
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The SKU List appears in ascending or descending order, first 
numerically then alphabetically, with respect to the SKU field.  The 
SKU List can be sorted in ascending or descending order with respect 
to any of the fields.  Click on the SKU, Description, Dims, Wgt, or 
SKU Info tab to sort the data respectively.   

Note:  The position of the SKU List – as well as the accompanying 
Manifest List – is fixed and always displays in the lower portion of the 
screen.  Regardless of the manifest or the tab selected, the SKU List 
and Manifest List will always appear. 

Manifest List (Truck Manifest) 

The Manifest List, displays a running list of all the selected SKU’s to be 
loaded into the container.  As you select SKU’s from the SKU List, they 
automatically appear in the Manifest List.  The Manifest List allows you 
to define specifics about the load; it contains both input fields and 
checkboxes that help tailor this load to your particular needs. 

 
Figure 4.12 Manifest List (Truck) 

Let’s take a look at the Manifest List. 

 SKU Type:  This column contains icons representing the SKU Type: 
unitload, shipcase, drum, tote or mixed pallet. 

 SKU:  This column contains the SKU Number, as defined in the 
Define SKU screen. 

 Qty: The Quantity column displays the number of a specific SKU or 
palletloads to be loaded in the container(s). 

If you choose to load a unitload (as defined in the Define Unitload 
screen), the quantity will represent the number of unitloads.  Though 
this might seem confusing at first, it makes sense if you remember the 
five types of SKU’s in the MaxLoad Pro system:  unitloads, shipcases, 
drums, totes and mixed pallets. 
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If the option “Load by SKU Ratio” under the Options tab is checked, 
the Qty column will represent the ratio on the quantity of the 
respective SKUs. 

 SO/Prior:  This column serves a dual purpose, allowing you to build a 
load using either Priority Numbers or Stop-Offs in the calculations.  
The Manifest List shows one field or the other – Stop-Offs or Priority 
– at all times.  To specify loading method to use, go to the Options tab 
and select one or the other.  If you don't need to use either loading 
method, simply leave all numbers in this column the same; that is, all a 
stop off or priority of “1”.  

The Stop-Off function allows you to consider the loading sequence 
when various drop-shipments need to be made.  If you enter "1" in this 
column, MaxLoad Pro will place this item at the end of the trailer, 
where it can be easily reached at the first stop.  A stop-off value of “2” 
places the item further forward in the vehicle, accessible at the second 
stop-off. 

If there's not enough room to load the entire stop-off onto the vehicle, 
MaxLoad Pro will remove all SKU’s that made up the stop-off, and 
will place all SKU’s for the stop-off onto the Cut List.  MaxLoad Pro 
will not partially load a stop-off.   

However, there is one exception to this functionality:  If the first stop-
off will not fit into the selected vehicle, MaxLoad Pro will break up 
the stop-off in an effort to load something.  While we understand that 
this functionality does sacrifice cubic utilization, our customers have 
indicated that this is the preferred way to handle this situation. 

The Priority function allows you to define the relative importance of a 
particular SKU when loading into a vehicle. All SKU’s with a priority 
of “1” will be loaded before SKU’s with a priority of “2,” which are 
loaded before SKU’s with a priority of “3,” and so on.  This means 
that all SKU’s with a Priority of “1” will generally be loaded before 
(and therefore in the front of the vehicle) SKU’s with a lower priority 
value. 

If there's not enough room to load all SKU’s with a particular priority 
value, MaxLoad Pro will load as much of the priority as possible, 
leaving the remaining SKU’s to be placed on the Cut List.  In other 
words, priorities can be split-up, unlike stop-offs.   

 UL: Allows you to place an SKU onto a unitload “on the fly.”  If 
you've previously created a unitload for a particular SKU, you can 
simply activate this checkbox and move on to the next field.  MaxLoad 
Pro will load these SKU’s using the pallet pattern you selected in the 
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Create Unitload screen when you defined the SKU.  If you've not 
created a unitload for this SKU, the field will be grayed out, meaning 
that you cannot activate this field.  In this case, you'll need to create a 
unitload in the Define SKU screen, then come back and activate the 
field.   

For more information, please refer to Chapter 3, Defining MaxLoad 
Pro Databases. 

Checking this box does not guarantee that all SKU’s will be loaded as 
part of a unitload.  How it is loaded will depend on the number of 
SKU’s that make up a complete unitload as defined in the Create 
Unitload screen.   

For example, suppose you've created a unitload that consists of 44 
cases of peanut butter.  If you want to load 88 cases of peanut butter, 
MaxLoad Pro will load all cases onto two complete unitloads.  
However, if your order calls for 70 cases of peanut butter, MaxLoad 
Pro will load one complete unitload (44 cases), and will either load the 
remaining 26 cases on the floor or as part of a mixed-pallet (if the 
Mixed Pallet column is checked).   

The Unitload functionality allows you to either floor load a selected 
SKU or load it as a unitload.  You may find that this feature comes in 
handy when you have products destined for two customers, but one 
requires SKU’s to be shipped on pallets, while the other does not.   

If you want to do this, simply select the SKU twice from the SKU List 
box.  This action will create two separate line items in the Manifest 
List.  Enter a quantity to be loaded as part of a unitload, then check the 
UL box.  Do the same for the second line item of the SKU, but this 
time do not check the UL box.  This will designate this group of SKU 
to be floor-loaded.  

You'll notice that this field may already be activated when you select a 
SKU from the SKU List.  This occurs when you activate the “Unitize” 
field when you define a SKU.  Remember, that you'll need to check 
this box even if only one SKU is to be shipped as part of a unitload.  
The column must be displayed in order to activate the UL field. 

Note:  UL and MP columns appear in the Manifest List only if the 
“Use Unitloads” and /or “Use Mixed Pallets” options are checked 
under the Options tab, respectively.   

 MP: MP stands for Mixed Pallet i.e. a palletload consisting of multiple 
kinds of SKU’s.  Creating a mixed-pallet on the fly allows you to 
choose a pallet type and have MaxLoad Pro load SKU’s onto that 
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pallet using either default parameters or the options you select through 
the Mixed-Pallet tab.   

MaxLoad Pro builds a default mixed pallet by layers, meaning that it 
will first look for full layers of SKUs before mixing and matching 
those layers.  MaxLoad Pro will not build a default mixed pallet using 
a column-building method.  Why not?  The results of this method are 
not always considered to be very stable. 

When you check the MP box, you assign all SKU’s in this row to 
either a unitload (if the UL box is checked) or to a mixed pallet.  When 
the MP box is checked, this particular SKU will not be floor-loaded.  
(unless you are using the Fill Item option) Using the scenario in the 
Unitload section, if 26 cases of peanut butter remain, all 26 cases 
would be loaded onto a mixed pallet when this column is checked. 

MaxLoad Pro builds a default mixed pallet by first looking to see if a 
unitload has been created for the SKU in question.  It will also 
determine if any parameters are similar – pallet, overhang, maximum 
height, etc.  If a unitload has been created and the parameters are the 
same, MaxLoad Pro will build full layers based on the patterns used 
when creating the unitload.  Once full layers have been built, the 
remaining items will be loaded loosely on top of the mixed-pallet.   

Example:  Suppose we've created a unitload that consists of four layers 
of peanut butter cases; each layer consists of 11 cases.  Taking into 
consideration the remaining 26 cases that are to be placed onto a 
mixed pallet, and assuming all parameters are the same, MaxLoad Pro 
will load two layers of peanut butter (using the same pallet pattern as 
the complete unitload), comprising 22 cases.  Then MaxLoad Pro will 
load the remaining four cases loosely on top of the mixed pallet.   

If any parameters have changed, this loading philosophy is thrown 
“out the window,” and MaxLoad Pro will determine the most efficient 
way to load the mixed pallet, taking into consideration the new loading 
parameters. 

 Order #: You have the option of assigning an order number to each 
SKU or group of SKU’s that you ship.  This column simply provides 
information that may be useful to your logistics staff.  Information 
keyed into this field will be available on certain printouts, which in 
turn can be used when loading the vehicle or pallet.   

On the Options tab, you can then tell MaxLoad Pro to keep items 
within the same order together.  If you do not use order numbers, you 
can uncheck the “Keep Same Orders Together” option under the 
Options tab.    
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 % Cube: This field specifies the total volume of the specified quantity 
of that particular SKU, UL, or MP will occupy in the container. 

 % Wgt: This field specifies the total weight of the specified quantity 
of that particular SKU, UL, or MP will weight with respect to the 
container. 

 Piece Count: Number of items which might be contained within a 
given SKU.  Piece Count is established per SKU, when defining the 
SKU. 

 Fill Item: This option is functional only if “Allow Loose Fill on 
Sides” option is checked under the Algorithm Options.  If this option 
is checked in the Manifest List, the user can select those SKU’s which 
do not form a unitload as fill items, to fill the empty available space in 
the container.      
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Expand Columns in the SKU List and 
Manifest List 
The SKU List and Manifest List each contain a number of columns.  
Sometimes, the column space might not be wide enough to accommodate 
all the information in that column.  You may need to widen the column to 
display more information. 

To expand a column in the SKU or Manifest List, follow these 
instructions: 

1. Position the mouse pointer on the edge of the column heading you 
want to expand.  For example, if you want to expand the Description 
column, point the mouse pointer (arrow) at the divider line between 
the Description and Dims columns, as pictured below. 

System Response:  The mouse pointer changes shape from a single 
arrow to a double-ended arrow, as pictured below. 

 
Figure 4.13 Expand Columns 

2. Using the double arrow, use the mouse to left-click on the column 
edge and drag the column to the desired width.  You can either expand 
or contract the width of the column. 

3. Once the column is expanded to the desired width, release the left 
mouse button.   

System Response:  The double arrow disappears, replaced with the 
standard mouse pointer.  When you release the mouse button, the new 
column width will be set. 

Note:  To expand or contract the width of the entire SKU or Manifest List, 
work through the same process with one exception:  Start by positioning 
the mouse pointer at the edge or border of the entire list itself.  The 
remainder of the steps are the same. 
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Defining a Truck Manifest 
To define a truck manifest, start from the Control Center and follow these 
instructions: 

1. Under the Truck Manifest box, click on the New button. 

System Response: The Manifest Pick List Screen appears. 

2. Select one or more vehicles from the list of Available Vehicles. 

System Response:  The selected vehicle(s) display in the Selected 
Vehicles list.  

3. Select the SKU’s to be loaded from the SKU List.  

System Response:  The selected SKU's display in the Manifest List. 

4. In the Manifest List, enter a quantity and specify other parameters like 
stop-off/priority, order number, etc. 

5. On the Options tab, designate which SKU’s are to be loaded as part of 
a unitload or together on a mixed-pallet. 

6. If everything is correct, click on the Calculate button. 

System Response:  MaxLoad Pro calculates solutions based on your 
input. 

7. Select the truck manifest solution from the Sol List that best meets 
your needs. 

8. From the Menu Bar, open the File menu and select Save As. 

System Response:  The File Save As dialog box appears. 

9. In the blank line at the top of the box, replace the word “Untitled” with 
the name of this truck manifest and click Save. 

Note:  Chapter 8, Viewing a Solution, describes in detail the options you 
have once a manifest has been calculated.  Chapter 9, Editing a Solution, 
discusses how to use the Editor to customize a solution.  Refer to those 
chapters for more details. 
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